Contents

GETTING STARTED ............................................................................................................. 5

SETUP CODES AND DESCRIPTIONS ................................................................................. 5

SETUP CEMETERY MAPPING ........................................................................................... 6

Cemetery Settings ............................................................................................................... 6

Map Settings ....................................................................................................................... 7
  Attach Underlay ................................................................................................................. 7
  Add new Sections ............................................................................................................... 8
  Place Zoom Markers ......................................................................................................... 8
  Add Lots/Plots .................................................................................................................... 9
  Layout Space ..................................................................................................................... 10
  Deleting a Section-Lot-Plot, etc. .................................................................................... 11
  Irregular Layouts ............................................................................................................... 12

Interface to Other BANYON DATA Applications .............................................................. 13

Create New Cemetery Record .......................................................................................... 15
  New Record Name ............................................................................................................. 15

Cemetery Screen ............................................................................................................... 15
  General Discussion .......................................................................................................... 15

Detail Entry and Maintenance ............................................................................................ 16

Space Info .......................................................................................................................... 16
  Attach Space Info in Cemetery screen .............................................................................. 16
  Attach Space Info in Customer screen .............................................................................. 17
  Contacts (Create, Attach, and Remove) .......................................................................... 18

Deeds .................................................................................................................................. 19

Maintenance ......................................................................................................................... 20

Military Service ................................................................................................................... 21

Genealogy ............................................................................................................................ 22

Marker .................................................................................................................................. 23

Burial .................................................................................................................................... 24

Authorization ......................................................................................................................... 25
GETTING STARTED

After installing the software, click on the BANYON DATA Property Management short cut on your computer’s desktop.

Enter your security password to access the system. The password “banyon” (upper or lower case) is provided as a default password.

To access the Cemetery Management software, it first must be turned on as an Add-On Module. If it is not turned on, please contact Banyon Data for a password.

SETUP CODES AND DESCRIPTIONS

To begin, first add descriptions. Click on Tools in the upper left menu and highlight Setup Options and then click on Codes and Descriptions. In the Cemetery Column click on the subject button and then in the open space on the right hand side of the screen, enter the common descriptions that you wish to see in the system options.

Please note that many of the fields have default descriptions. However, as you create specific descriptions for fields they may be added as you wish.
Before you can attach a plot or site to the deceased, you must first set up the Cemetery mapping.

Go to Tools in the upper left corner menu. Highlight Setup Options, select Cemetery.

Click on Options in the upper right corner, then select Global Settings

**Cemetery Settings**

The cemetery management settings can be partitioned to five (5) tiers. The first field is for the Entity Name and the system will automatically fill that in. Unless you have one Cemetery, the second field should be named Cemetery. You can name your partitions whatever you wish, we have used blocks, lots, sections and plots as examples. As you can see, we have one cemetery that breaks down into Sections and plots.

Enter the path to the folder that holds your maps (Underlay). You can also search for the folder by clicking on Locate Map Folder.

Select the color codes you wish for each field. When you have finished your selections click on the X in the right corner of the window.
Map Settings

Attach Underlay
To help with the visual structure of your Cemetery you can attach a map as an Underlay. **An underlay is a map.** Click on Attach Underlay. Select the picture (map) that you will have previously saved to your computer.

This first map shows an overall view of our Cemetery. We will continue to build on this map.

- If your first partition is Cemetery then this first map would be a map of your city, showing the locations of your cemeteries.
- To keep the maps appearing proportional and less distorted, save them as bitmaps in a size of 6”x6”.
Add new Sections
The next step is to add Sections. Click on **Add New Sections**.

Enter the new sections.

The sections will list on the left side under **Section ID**.

Place Zoom Markers
Click on **Place Zoom Marker**. A yellow box with a red x will appear on the screen. Left click on the map in the section that you want to place the marker. Select the section name/number from the drop down menu that appears after you have left clicked. The system will place the marker in the section with the section name/number in it.

If you did not create enough sections, you can add the sections now by entering the name/number in the **Create New Marker** box.
Add Lots/Plots
Next you want to setup the next level down. In this case we are setting up the Plot level. Click on the Section name/number under Section ID or click on the section name/number on the map (the yellow box with the Section ID in it). You will see the next level screen, in our case it is the Plot screen.

You can again attach the Underlay map if you wish. Follow the previous instructions.

Click on Add New Plot(s).

Click Ok when it asks if it’s Ok to add Plots. The systems will list the Plots under Plot ID on the left side of the screen.

Click on Position Grid.

Drag the grid to the position on the screen you want it. Left click and a copy of the grid will stay in that position. Note the grid information in the lower right corner. The grid size is the over all dimension of the grid. The Grid top Left is where the top left corner of the grid is positioned on the screen. Plot Size is the dimension of each plot. Plot Scale is used to make the grid fit within you.
Layout Space
Click on Layout Space. Spaces can be entered one at a time (usually used for unusual shaped sections) or by block. To enter by space, click on Per Space on the right side of the window. Click on the Plot name/number listed under Plot ID on the left side of the window then click on the space inside the grid.

To enter by block, highlight the range of spaces under Plot ID. Click on Per Block. Left click and hold in the top left space of the grid, drag down and to the bottom left space of the grid block.
Click on the arrow at the starting point, pointing in the direction that you wish to fill the block. In this case I have selected the arrow in the top left corner pointing to the right. My grid will fill from left to right, top to bottom.

Follow the above mapping setup steps for each section.

Deleting a Section-Lot-Plot, etc.
Under the ID column on the left side of the screen, highlight the Section, Lot, Plot, etc. name/number. Press your delete key on your keyboard.

Note: If you make a mistake or don’t like the way it looks click on Undo and the layout will revert to the way it looked before.
Irregular Layouts

Follow the same steps as you would for the regular shaped sections. For the irregular shaped sections, the grid should cover the entire area of the section. There can be only one defined grid per section, in other words, you cannot piece together parts of the section. The grid size is rows by columns where the rows and columns are the longest row and the longest column in the section.
Interface to Other BANYON DATA Applications

The final setup step is to Interface to other BANYON DATA Applications. Go to Tools in the top left corner of your window. Highlight Setup Options, click on Interface to Other BANYON DATA Applications.

This is where you enter-Locate the respective paths to Fund Accounting, Utility Billing and Property Tax.

If you are using Utility Billing, you have the option to copy existing Customers and Property records from Utility Billing – ONE TIME. After that, you would want to choose to Synchronize Property and Customer Records with Utility Billing for normal file maintenance.
Select on the menu in the upper left corner; **View – Inquiry – Cemetery**.

For purposes of maintaining a consistent and complete database, the word “customer” is used to describe any record that holds people information in the system, including the owner, occupant of site (deceased), contacts, relatives. This name may be changed for reports if needed.

So, if you are adding new or editing existing records, you will select; **View – Inquiry – Cemetery**, from the top left hand corner of the Property Management screen.

To add a new record, click on the >* (Add Button) in the lower left corner. The Customer screen or window will appear and should be completed with the record information. Again, the cemetery screen is generally completed for the deceased individual. Contact information is setup as part of the Cemetery screen.
Create New Cemetery Record

New Record Name
Click on View in the upper left corner of your screen, highlight Inquiry, click on Cemetery. Click on the Add Record Button (>*). If the new owner is deceased, select *New Burial Record Only (this will create an entry in the Cemetery database only). Enter the name of the deceased (Example: Doe, John). Press the Enter Key when finished.
If the new owner is a living being with a loved one to execute final wishes for or is just planning ahead, Click on the Add Record Button(>*). Select *New Customer/Burial Record (this will create an entry in the Customer database and the Cemetery database). Enter the name of the new customer; remember to follow the Last name first and First name last format.
The system will prompt you for the name of the Deceased, if the deceased’s name is other than the new customer, enter the deceased’s name, otherwise enter past the deceased name screen. The Customer screen will come up. Enter the desired customer information and close the Customer screen. The Cemetery screen will remain.

Cemetery Screen

General Discussion
First enter in the Maiden name if applicable, gender, date of birth, and place of birth. It is recommended that you complete the tabs in order from left to right. First enter Space Info Tab information, then Contact, Deed, and so on.

Be aware that all fields are not necessary to use the Cemetery Software. However, to maximize or optimize the record keeping and reporting, it is recommended that all fields be completed.
Detail Entry and Maintenance

Space Info
Attach Space Info in Cemetery screen
Left click on Attach/Detach Space

Highlight the section, click on the plot.

View Map will take you to the plot in the map for visual confirmation.

You attach one space or plot per individual Cemetery/Burial record.
Attach Space Info in Customer screen
Click on View in the upper left corner of the screen, highlight Inquiry, click on Customer. Click on the Cemetery tab. Left click on Attach a Space in the lower left corner of the window. Highlight the section, click on the plot.

Note that the information is now in the Space Information table.

More than one space can be attached to a Cemetery Customer.
Contacts (Create, Attach, and Remove)

The Contacts Tab shows the information you specified for the customer (deceased) contact setup. The fields are used to record the person or entity responsible for the burial matters. To add a contact, click on Attach Contact. A list or menu of names will appear or you may choose to click on the Create New Contact option at the top of the menu.

When entering New Contact to the Cemetery Record, enter the desired Contact Name (Last name, First name), or use the drop down menu and select and click on the name.

To enter in a street address for a new contact click on more info at the bottom right and select personal. Then enter the address, email, home phone, work phone, and email while on the personal screen.

Multiple contacts may be attached to the deceased record, but only one may be the primary contact. An * will indicate the primary contact.
Deeds

The Deeds Tab contains the registered vital burial information recorded at the City and/or County. Burial permit information, if used, may also be recorded on this screen.

Enter the specific Deed information and close the Window or click on the next Tab (Maintenance). The completed Deed Screen will contain detail, recorded information for each field.

You can view the Death Certificate if it had been scanned and placed in the provided area accessed by clicking on the Death Certificate Image option. You can also print a copy of the Death Certificate (not official copy) by clicking on the Print option.
Maintenance

The Maintenance Tab records maintenance types and jobs and can store a next maintenance date. To add new or updated maintenance information, click on the Add New Maintenance option in the lower left.

Next, enter the completion date and press enter. Press the Esc key to cancel.

Then complete the detailed maintenance record and do not forget the total charges as these are needed to interface to the Receipt Entry Option and the Point of Sale module (if applicable). You can also print a maintenance history by clicking on the Print History option.

Once the total charge has been entered the Balance Due field on the Cemetery screen will be update and the amount may be paid by clicking on the Balance Due. The balance can also be paid via the Receipt Entry process.
Military Service

The Military Service Tab can record important information about the deceased military service record including branch, rank, overseas service, enlistment date, discharge date, campaigns, medal(s) awarded, etc.

Complete the fields if available and close screen or click on next tab.
Genealogy

The Genealogy tab contains information about the deceased ancestry. This is an option tab but provided for the family of the deceased and others looking for a family history of the deceased.

To enter information, just click on the open cell and enter information. Close screen when finished or proceed to next tab (Marker).
Marker

The Marker tab contains information specific to the marker on the plot.

A photo insert is also available to help identify the site. Click on the photo box and locate the saved *.jpg or *.bmp file.
**Burial**

The Burial screen contains data about the burial including date, burial number, funeral home used, authorizing person or organization. Notes are also available to enter specific burial requests or concerns.

![Burial Screen](image)

**Note:** Do not delete a record without first making a backup. See Backup and Restore section at the back of this User Guide.
Authorization

The Authorized or Permission Tab includes individuals that have permission to be buried at the subject plot in the cemetery. When a person has permission they are also included as a customer in the system.
Receipt Entry

Receipt Entry Option

To enter receipts for contact payments of maintenance or plot purchases, click on the View menu option at the upper left corner and click on Receipt Entry.

Select Create New Batch to start a new set of payments. Or, click on an existing batch to append to it. If creating a new batch, enter a new batch name or accept the existing default name (date).

Before you begin entering receipts this first time you may want to set your Receipt options. Click on Receipting Options.

Click on the down arrows to the right of each column and select the desired option.
Now enter in the first open row, name or address or any context of entry for the customer’s payment and press ENTER.

List of matches will show in a Window. Select the correct match by clicking or pressing enter.

If an amount is due on the customer record the amount will be displayed in the amount field.

Enter the check # if you like and change the remark if necessary. Continue to add payments for each row. When the batch is completed, Preview and print the Report. Post the Receipt. Remember before you post a batch; make a backup. The system will prompt for this step.
Additional way to enter payments:

Payments may also be made from the Main Cemetery Screen Balance Due Field. Click on the Balance Due option and create a new batch or add to an existing batch.

You will then see a menu to create a new batch or add this entry to an existing batch that you have open.

You can look up an existing customer under view inquiry cemetery.

Once the receipts are posted, they may be transferred (distributed) to BANYON DATA Fund Accounting if available. To distribute receipts, click on View in the upper left corner of the screen. Highlight Receipt Entry, click on Receipt Distribution. Select the batch to distribute, select how you want to summarize (by Account or Item). Click on print in the lower left corner to print the report. Click on the amount to distribute.
Report Writer

To access the Report Writer module, click on the View menu option in the upper left corner of screen and click on Report Writer menu option.

Click on the report Category /Collection in the left window. A selection of reports will appear in the Report window on the right side.

Click on the desired report and click on Preview Selected Report.

Right click on the specific report and you can preview, print, sort or filter.

To create a NEW report right click in the right hand box and select New.
**Backup and Restore**

To make a data backup or restore a previously backup set of data click on the Tools menu option in the upper left corner and click on Backup/Restore menu option.

**Setup**

First, click on the Setup Tab and enter your preferred backup locations. A minimum of two is recommended.

![Backup and Restore Setup Window](image)

**Backup**

Click on the Backup/Restore Tab, **Right click** in the open area of the Backup/Restore Window and click on create new. Enter the name of the backup and press enter.

![Backup and Restore Backup Window](image)

**Restore**

Click on the backup you wish to restore to select it. **Right click** and select Restore selected backup. If you do not see the required backup right click and select Locate Unlisted Backup.